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1. L. S. Compliance In Review

L.S. Compliance - Accreditations and Listing’s

As an EMC Testing Laboratory, our Accreditation and Assessments are recognized
through the following:

A2LA — American Association for Laboratory Accreditation
Accreditation based on ISO/IEC 17025 : 1999
with Electrical (EMC) Scope of Accreditation
A2LA Certificate Number: 1255.01

Federal Communications Commission (FCC) — USA
Listing of 3 Meter Semi-Anechoic Chamber based on Title 47 CFR — Part 2.948
FCC Registration Number: 90756

Industry Canada
On file, 3 Meter Semi-Anechoic Chamber based on RSS-212 — Issue 1
File Number: IC 3088-A

On file, 3 and 10 Meter OATS based on RSS-212 — Issue 1
File Number: IC 3088

U. S. Conformity Assessment Body (CAB) Validation
Validated by the European Commission as a U. S. Competent Body operating under
the U. S. /EU, Mutual Recognition Agreement (MRA) operating under the European
Union Electromagnetic Compatibility —Council Directive 2004/108/EC (formerly
89/336/EEC, Article 10.2)
Date of Validation: January 16, 2001

Validated by the European Commission as a U.S. Notified Body operating under the
U.S./EU, Mutual Recognition Agreement (MRA) operating under the European Union
Telecommunication Equipment — Council Directive 99/5/EC, Annex V.

Date of Validation: November 20, 2002
Notified Body Identification Number: 1243
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3. Product and General Information

Manufacturer: | Heat-Timer Corporation
Date(s) of Test: | February 8" through 24™, 2006
Test Engineer(s): | Tom Smith | V| Abtin Spantman | | Ken Boston
Model #: | 900 MHz RF Module
Serial #: | 05510529 and 05510534
Voltage: | 3.3 VDC
Operation Mode: | Normal, continuous modulated transmit, and ‘Hopping’ mode

4, Introduction

Between February 8™ and 24™, 2006, a series of Conducted and Radiated RF Emission tests
were performed on two samples of the Heat-Timer Corporation’s 900 MHz RF Modules, serial
numbers 05510529 and 05510534, here forth collectively referred to as the “Equipment Under
Test’ or “EUT’. These tests were performed using the procedures outlined in ANSI C63.4-2003
for intentional radiators, and in accordance with the limits set forth in FCC Part 15.247 (Industry
Canada RSS-210) for a low power transmitter. These tests were performed by Abtin Spantman,
EMC Engineer at L.S. Compliance, Incorporated.

All Radiated and Conducted RF Emission tests were performed upon the EUT to measure the
emissions in the frequency bands described in FCC Title 47 CFR Part 15, including 15.35,
15.209, 15.247 and Industry Canada RSS-210 to determine whether these emissions are below
the limits expressed within the standards. These tests were performed in accordance with the
procedures described in the American National Standard for methods of measurement of Radio-
Noise Emissions from Low-Voltage Electrical and Electronic Equipment in the Range of 9 kHz to
40 GHz (ANSI C63.4-2003). Another document used as a reference for the EMI Receiver
specification was the Comite International Special Des Perturbations Radioelelectriques (CISPR)
Number 16-1, 2003.

All tests were performed at L.S. Compliance, Inc., in Cedarburg, Wisconsin, unless otherwise
noted.
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5. Product Description

The Heat-Timer 900 MHz RF Module is a Frequency Hopping transceiver module operating in
the 902-928 MHz ISM band, as qualified under 47CFR Part 15.247. The transmit characteristics
of this transceiver were tested and the results are covered in this report.

The module has a 3.3 VDC, 175 mA nominal voltage and current requirement, and is designed
to operate on 25 channels, with a nominal RF power output of 250 mW. The module may be
powered from batteries or from AC wall adaptors. Power and data pins are available through a
standard 0.1” header on the module. The module may be fitted with a reverse gendered SMA
connector for the different antennas, or with a wire whip antenna directly soldered onto the
module. The Module is based on a single chip RF transceiver processor, which is capable of
operating at 200 kbps, with FSK modulation techniques.

The Heat-Timer 900 MHz RF Transceiver Module,
shown with the SMA-RP connector configuration.
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The Module is tested and qualified in three types of antenna configurations:

Configuration Antenna MFG Model
1 Antenna Factor ANT-916-CW-RH
2 Antenna Factor ANT-916-MHW-RPS
3 “Generic Wire Whip” | 8 cm long, 22 AWG

The Module was placed in test modes using a special test-board fixture, with an on-
board RS-232 translator, and programming dip switches. The module was connected to
the test-board fixture using and extension ribbon cable.

The Modules and antenna configurations shown on the right,
And the test-board fixture shown on the left.

I
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6. Test Requirements

The above mentioned tests were performed in order to determine the compliance of the
transmitter portion of the Heat-Timer “900 MHz RF Module” with limits contained in various
provisions of Title 47 CFR, FCC Part 15, including:

15.205 15.247a 15.247d
15.207 15.247b 15.247¢g
15.209 15.247c 15.247i

7. Summary of Test Report

DECLARATION OF CONFORMITY

The Heat-Timer “900 MHz RF Module” was found to MEET the requirements as described
within the specification of Title 47 CFR FCC, Part 15.247, and Industry Canada RSS-210,
Section 6.2.2(0) for a Frequency Hopping Spread Spectrum Transmitter.

The enclosed test results pertain to the sample(s) of the test item listed, and only for the tests
performed on the data sheets. Any subsequent modification or changes to the test items could
invalidate the data contained herein, and could therefore invalidate the findings of this report.

Some emissions are seen to be within 3dB of their respective limits. As these levels are within
the tolerances of the test equipment and site employed, there is a possibility that this unit, or a
similar unit selected out of production may not meet the required limit specification if tested by
another agency.
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8. Radiated Emissions Test

Test Setup
The test setup was assembled in accordance with Title 47, CFR FCC Part 15 and ANSI C63.4-

2003. The EUT was placed on an 80cm high non-conductive pedestal, centered on a flush
mounted 2-meter diameter turntable inside a 3 meter Semi-Anechoic, FCC listed Chamber. The
EUT was operated in continuous transmit mode, using power as provided by a wall type power
supply. The unit has the capability to operate on 25 channels, controllable via dip switches, on a
custom test-fixture board during the testing.

The applicable limits apply at a 3 meter distance. Measurements above 1 GHz were performed
at a 1.0 meter separation distance. The calculations to determine these limits are detailed in the
following pages. Please refer to Appendix A for a complete list of test equipment. The test
sample was operated on one of three (3) standard channels: low (903.0 MHz), middle (915.0
MHz) and high (927.0 MHz) to comply with FCC Part 15.35. The channels and operating modes
were changed using DIP-switches on the test-fixture board, and monitored via a lap-top PC.

Three antenna configurations are tested and qualified with the module in this report. The
antenna specifications can be found in the appendices.

Test Procedure

Radiated RF measurements were performed on the EUT in a 3 meter Semi-Anechoic, FCC
listed Chamber. The frequency range from 30 MHz to 10000 MHz was scanned and
investigated. The radiated RF emission levels were manually noted at the various fixed degree
settings of azimuth on the turntable and antenna height. The EUT was placed on a non-
conductive pedestal in the 3 meter Semi-Anechoic Chamber, with the antenna mast placed such
that the antenna was 3 meters from the EUT. A Biconical Antenna was used to measure
emissions from 30 MHz to 300 MHz, and a Log Periodic Antenna was used to measure
emissions from 300 MHz to 1000 MHz. A Double-Ridged Waveguide Horn Antenna was used
from 1 GHz to 18 GHz. The maximum radiated RF emissions were found by raising and
lowering the antenna between 1 and 4 meters in height, using both horizontal and vertical
antenna polarities.

The EUT was rotated along three orthogonal axis during the investigations to find the highest
emission levels.
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Test Equipment Utilized

A list of the test equipment and antennas utilized for the Radiated Emissions test can be found in
Appendix A. This list includes calibration information and equipment descriptions. All equipment
is calibrated and used according to the operation manuals supplied by the manufacturers. All
calibrations of the antennas used were performed at an N.I.S.T. traceable site. In addition, the
Connecting Cables were measured for losses using a calibrated Signal Generator and a HP
8546A EMI Receiver. The resulting correction factors and the cable loss factors from these
calibrations were entered into the HP 8546A EMI Receiver database. As a result, the data taken
from the HP 8546A EMI Receiver accounts for the antenna correction factor as well as cable
loss or other corrections, and can therefore be entered into the database as a corrected meter
reading. The HP 8546A EMI Receiver was operated with a resolution bandwidth of 120 kHz for
measurements below 1 GHz (video bandwidth of 300 kHz), and a bandwidth of 1 MHz for
measurements above 1 GHz (video bandwidth of 1 MHz). From 5 GHz to 10 GHz, an HP E4407
Spectrum Analyzer and an EMCO Horn Antenna were used.

Test Results

The EUT was found to MEET the Radiated Emissions requirements of Title 47 CFR, FCC Part
15.247 for a FHSS transmitter [Canada RSS-210, Clause 6.2.2(0)]. The frequencies with
significant RF signal strength were recorded and plotted as shown in the Data Charts and
Graphs.
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CALCULATION OF RADIATED EMISSIONS LIMITS

The maximum peak output power of an intentional radiator in the 902-928 MHz band, as
specified in 47 CFR 15.247 (b)(2), is 0.25 Watts for systems employing less than 50 hopping
channels, but at least 25 hopping channels. The harmonic and spurious RF emissions, as
measured in any 100kHz bandwidth, as specified in 15.247 (d), shall be at least 20 dB below the
measured power of the desired signal, and must also meet the requirements described in
15.205(c).

The following table depicts the Class B limits for an unintentional radiator. These limits are
obtained from Title 47 CFR, Part 15.209, for radiated emissions measurements. These limits
were applied to any signals found in the 15.205 restricted bands.

Frequency (MHz) 3 m Limit (uV/m) 3 m Limit (dBpV/m) 1 m Limit (dBpV/im)
30-88 100 40.0 -
88-216 150 43.5
216-960 200 46.0 -
960-25,000 500 54.0 63.5

Sample calculations:
Sample conversion from a field conducted RF power measurement in mW to a radiated Electric-Field
Intensity (EFI) measurement in dBuV/m would be:

dBuV Im@ 3m =95.23 + 10Logm(

XXmW j

ImwW

AT the fundamental frequency, the limit for the RF power output of 0.25W (250mW) at the antenna port of
a transmitter with an antenna gain of 0 dBi would be equivalent to an Equivalent Isotropic Radiated Power
(e.i.r.p.) measurement of 119.2 dBuV/m at 3 meters.

119.23dBxV /m @ 3m = 95.23 + 10L0910(Mj

ImW

Note: 47CFR 15.247 (b)(4) allows use of antennas with directional gains up to 6 dBi , which in effect allows
for the EFI Limit to be increased by 6 dB.

When invoking 15.247 (b)(4), the effective EFI Limit is:
Effective EFI Limit = 119.2 dBxV/m + 6 dB = 125.2 dBxV/im @ 3m.

Sample conversion from a measurement distance of 3 meters to a distance of 1meter would be:

XXm
dB =-20Log,,| ——
o 22)

A sample limit, within the frequency range of 960-25,000 MHz for example, when measured at 1 meter
instead of 3 meters would change according to the equation:

63.5dBuV /m =54.0dBuV /'m + (— 20Loglo(:13—mD
m
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Radiated Emissions Data Chart
3 Meter Measurements of Electromagnetic Radiated Emissions
Test Standard: 47CFR, Part 15.205 and 15.247(FHSS)
Frequency Range Inspected: 30 MHz to 10000 MHz

Manufacturer: | Heat-Timer Corporation

Date(s) of Test: | February 8™ through 24™ 2006

Test Engineer(s): | Tom Smith |V | Abtin Spantman | | Ken Boston

Model #: | 900 MHz RF Module

Serial #: | 05510529 and 05510534

Voltage: | 3.3 VDC

Operation Mode: | Normal, continuous modulated transmit, and ‘Hopping’ mode

EUT Power: Single Phase VAC 3 Phase VAC
' Battery | Other: Bench DC Supply
EUT Placement: | V 80cm non-conductive table 10cm Spacers
. 3 Meter Semi-Anechoic
EUT Test Location: | ECC Listed Chamber 3/10m OATS

Measurements: Pre-Compliance Preliminary \ | Final

Detectors Used: Peak v | Quasi-Peak \ | Average
Environmental Conditions in the Lab: Test Equipment Used:
Temperature: 20 — 25°C EMI Measurement Instrument: HP8546A and Agilent E4407B
Relative Humidity: 30 — 60 % Log Periodic Antenna: EMCO #93146

Horn Antenna: EMCO #3115
Biconical Antenna: EMCO 93110
Pre-Amp: Advanced Microwave WLAG22-4

Tabulated data for all three antenna configurations are presented on the following 4 pages.
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The following table depicts the level of significant spurious radiated RF emissions found:

Frequency Ant. Pol. Channel Height Azimuth | Measured EFI | 15.205 Limit | Margin
(MHz) Sens/EUT | / Configur. (m) (0° - 360°) (dBuV/m) (dBpVim) (dB)
49.2 VIS H/2 1.00 135 34.4 40.0 5.6
55.3 VIS H/2 1.00 135 37.4 40.0 2.6
61.5 VIS H/?2 1.00 130 39.1 40.0 0.9
73.7 VIS H/2 1.00 90 38.2 40.0 1.8
104.5 VIS H/2 1.00 175 38.2 43.0 4.8
133.2 VIS H/2 1.00 55 38.1 43.0 4.9
178.2 VIS H/2 1.00 55 32.3 43.0 10.7
608.8 H/H L/2 1.30 180 30.7 46.0 15.3
790.2 VIV L/1 1.15 0 62.3 99.0 tee2) 36.7
800.7 H/H M/3 1.00 60 55.3 101.4 woe2) 46.1
839.1 H/H L/3 1.00 55 59.8 102.1 e 42.3
846.7 H/H L/3 1.00 55 55.4 102.1 woe2) 46.7
851.1 H/H M/3 1.00 60 60.0 101.4 woe2) 41.4
862.9 H/H H/3 1.60 55 54.6 99.8 noe2) 45.2
870.9 H/H L/3 1.00 55 58.8 102.1 w2 43.3
887.1 VIV L/2 1.10 130 65.7 1015002 35.8
895.1 H/H H/3 1.60 55 55.4 99.8 e 44.4
928.2 H/H H/3 1.60 55 55.6 99,8 noe2) 44.2
931.1 VIV M/1 1.10 45 62.1 98.4 i) 36.3
935.1 VIV L/1 1.15 0 50.2 99.0 e 48.8
942.9 VIV H/1 1.10 60 60.8 97.5nee2) 36.7
946.9 VIV M/1 1.10 45 49.2 98.4 i) 49.2
958.9 H/H H/2 1.25 155 52.9 100.9 wwoe2) 48.0
974.9 H/H H/?2 1.25 155 46.4 54.0 7.6
979.1 H/H M/3 1.00 60 46.3 54.0 7.7
990.9 H/H H/2 1.25 155 51.4 54.0 2.6
990.9 H/H H/3 1.60 55 47.8 54.0 6.2

Notes:
1) A Quasi-Peak Detector was used in measurements below 1 GHz, and an Average Detector was used in measurements
above 1 GHz. The Peak detector was also use to ensure that the emission levels do not exceed 20 dB beyond the Average limits.
No significant spurious emissions observed. All spurious emissions were better than 20 dB below the limits.
2)  Thelimitis expressed as (-20 dBc) under the 15.247 guidelines, with respect to the appropriate center frequency of
operation.
3)  Measurements above 5 GHz were made at 1 meters of separation from the EUT, and at 0.3 m separation for frequencies
between 18-25 GHz.
4)  Measurement at receiver system noise floor.
5)  “Ant. Pol. Sens/EUT” column indicates the orientation of the EUT with respect to the sense antenna. The notation is defined
as: Vertical="V", Horizontal="H" and Side="S".
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The follo

Antenna Configuration 1 : (ANT-916-CW-RH)

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Low Channel:

Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit | Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBpV/m) (dB)
903 VIV 1.10 0 119.0 125.2 6.2
1806 VIS 1.00 80 55.4 108.5 53.1
2709 V/H 1.00 90 46.1 63.5 17.4
3612 V/H 1.00 0 48.2 63.5 15.3
4515 H/H 1.00 0 47.8 63.5 15.7
5418 H/S 1.00 330 50.0 63.5 135
6321 H/S 1.00 90 45.0 108.5 63.5
7224 H/S 1.00 70 41.7 108.5 66.8
8127 H/S 1.15 270 38.7 63.5 24.8
9030 H/S 1.15 270 40.0 63.5 23.5

wing table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Mid Channel:

Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT (meters) (0° - 360°) (dBuV/im) (dBuV/m) (dB)
915 VIV 1.10 45 1184 125.2 6.8
1830 VIS 1.25 270 63.5 107.9 44.4
2745 V/H 1.00 90 45.7 63.5 17.8
3660 V/H 1.00 0 47.9 63.5 15.6
4575 H/H 1.00 90 47.5 63.5 16.0
5490 H/S 1.25 85 51.3 107.9 56.6
6405 H/S 1.20 175 48.8 107.9 59.1
7320 H/S 1.10 5 41.7 63.5 21.8
8235 H/S 1.00 170 35.5 63.5 28.0
9150 H/S 1.00 30 39.6 63.5 23.9

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on High Channel:

Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBuVv/m) (dB)
927 VIV 1.10 60 1175 125.2 7.7
1854 VIS 1.00 175 61.2 107.0 45.8
2781 V/H 1.00 90 46.2 63.5 17.3
3708 V/H 1.00 0 48.0 63.5 155
4635 H/H 1.00 270 47.8 63.5 15.7
5562 H/S 1.20 85 49.4 107.0 57.6
6489 H/S 1.15 175 45.1 107.0 61.9
7416 H/S 1.05 10 432 63.5 20.3
8343 H/S 1.05 210 35.8 63.5 21.7
9270 H/S 1.05 330 40.4 107.0 66.6

L.S. Compliance, Inc.
Test Report Number: 305440-Tx-v1
Prepared For: Heat-Timer Corporation

Page 14 of 53




The follo

Antenna Configuration 2 : (ANT-916-MHW-RPS)

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Low Channel:

Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit | Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBpV/m) (dB)
903 VIV 1.30 180 1215 125.2 37
1806 H/V 1.00 45 64.8 111.0 46.2
2709 HIV 1.00 0 50.3 63.5 13.2
3612 H/V 1.00 0 52.4 63.5 11.1
4515 H/V 1.00 0 52.2 63.5 113
5418 (Note 4) 63.5
6321 (Note 4) 111.0
7224 (Note 4) 111.0
8127 (Note 4) 63.5
9030 (Note 4) 63.5
wing table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Mid Channel:
Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT (meters) (0° - 360°) (dBuV/im) (dBuV/m) (dB)
915 VIV 1.30 155 1213 125.2 3.9
1830 HIV 1.00 40 63.3 110.8 475
2745 H/V 1.00 0 50.4 63.5 13.1
3660 H/V 1.00 0 52.5 63.5 11.0
4575 HIV 1.00 0 52.2 63.5 113
5490 (Note 4) 110.8
6405 (Note 4) 110.8
7320 (Note 4) 63.5
8235 (Note 4) 63.5
9150 (Note 4) 63.5
The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on High Channel:
Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBuVv/m) (dB)
927 VIV 1.30 155 120.9 125.2 4.3
1854 H/V 1.00 20 64.5 1104 45.9
2781 H/V 1.00 0 50.6 63.5 12.9
3708 H/V 1.00 0 52.5 63.5 11.0
4635 H/V 1.00 0 52.3 63.5 11.2
5562 (Note 4) 1104
6489 (Note 4) 1104
7416 (Note 4) 63.5
8343 (Note 4) 63.5
9270 (Note 4) 1104
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Antenna Configuration 3 : (Generic Wire Whip)

The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Low Channel:

The follo

Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit | Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBpV/m) (dB)
903 H/H 1.00 55 122.1 125.2 3.1
1806 H/V 1.00 100 62.9 111.6 48.7
2709 HIV 1.00 90 51.4 63.5 12.1
3612 H/V 1.00 0 52.6 63.5 10.9
4515 H/V 1.00 0 52.6 63.5 10.9
5418 (Note 4) 63.5
6321 (Note 4) 111.6
7224 (Note 4) 111.6
8127 (Note 4) 63.5
9030 (Note 4) 63.5
wing table depicts the level of significant radiated RF fundamental and harmonic emissions seen on Mid Channel:
Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT (meters) (0° - 360°) (dBuV/im) (dBuV/m) (dB)
915 H/H 1.00 60 1214 125.2 3.8
1830 HIV 1.05 190 66.9 110.9 44.0
2745 H/V 1.00 0 50.8 63.5 12.7
3660 H/V 1.00 0 52.4 63.5 11.1
4575 HIV 1.00 0 52.4 63.5 111
5490 (Note 4) 110.9
6405 (Note 4) 110.9
7320 (Note 4) 63.5
8235 (Note 4) 63.5
9150 (Note 4) 63.5
The following table depicts the level of significant radiated RF fundamental and harmonic emissions seen on High Channel:
Frequency | Ant. Pol. Height Azimuth Measured EFI 15.247 Limit Margin
(MHz) Sens/EUT |  (meters) (0° - 360°) (dBuV/m) (dBuVv/m) (dB)
927 H/H 1.60 55 119.8 125.2 54
1854 H/V 1.00 120 66.0 109.3 43.3
2781 H/V 1.00 0 50.9 63.5 12.6
3708 H/V 1.00 0 52.7 63.5 10.8
4635 H/V 1.00 0 52.4 63.5 11.1
5562 (Note 4) 109.3
6489 (Note 4) 109.3
7416 (Note 4) 63.5
8343 (Note 4) 63.5
9270 (Note 4) 109.3
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View of the EUT setup in vertical orientation
Antenna configurwn 1 shown in this series of photos.

View of the EUT setup in Side orientation
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Front view of the EUT setup on the test stand as seen from the sense antenna.

| M@J o
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View of the EUT antenna defined in vertical orientation, with module PCB in various
orientation. Antenna configuration 2 shown in this series of photos.
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View of the EUT setup in vertical orientation
Antenna configuration 3 shown in this series of photos.

View of the EUT setup in Side orientation
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Graphs made during Radiated Emission Testing

Screen Captures of Radiated RF Emissions:
Please note these screen captures represent Peak Emissions. For radiated emission measurements, we
utilize a Quasi-Peak detector function when measuring frequencies below 1 GHz, and an Average detector
function when measuring frequencies above 1 GHz.

The signature scans shown here are from worst-case emissions among all three antennas tested, as
measured on Low, Middle and High channels, and with the sense and EUT antennas both in vertical
polarity for worst case presentations.

Configuration 2, High Channel, Sense Antenna Vertically Polarized, 30-300 MHz, at 3m.
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High Channel, Sense Antenna Vertically Polarized, 300

-902 MHz, at 3m.
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Highest Measured EFI at Fundamental Frequencies:
Configuration 3, Low Channel, Sense Antenna Horizontally Polarized, 902-928 MHz, at 3m.

@1'—|:35:"|3 ¢l FEE CHPE Last Hrd

STOP ACTU DET: PEAK Key fenu
928, 0 HHz MEAS DET: PEAK OP AYG .
MKR 983.17 HH:
122.17 dBuben |
LG REF 125.8 dBulb/n GLIES
T )L
dB/ ﬁ MARKER
ATH
58 a5 || a
I \ NEXT
I L PEfK
P AV T AU IV SOOI Y NS DRI PR
T NEXT P
S0 FL RIOHT
RCORR
NEXT P
LETT
START 9A7. A0 NH: 5TOF 926.080 fiHz More
R #IF BN 120 kHz  RAUG BW 388 kH: SWP 24 4 mgec 1 af 7

Lowest Measured EFI at Fundamental Frequencies:
Configuration 1, High Channel, Sense Antenna Vertically Polarized, 902-928 MHz, at 3m.
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L.S. Compliance, Inc. Page 22 of 53

Test Report Number: 305440-Tx-v1
Prepared For: Heat-Timer Corporation



Configuration 1, Middle Channel, Sense Antenna Vertically Polarized, 928-1000 MHz, at 3m.
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Configuration 1, High Channel, Sense Antenna Horizontally Polarized, 1000-5000 MHz, at 1m.

% Agilent  15:58:33 Feb 9, 2006 | Peak Search |
Mkrl 1.868 GHz|t
Ref 75 dBpV #Atten B dB Ext PG -0.34 dB 60.44 dBpv
Peak Meas Tools»
Log
5
dB/ Next Peak
1
o
ol Next Pk Right
63.5
dBpY
Next Pk Left
Y1 52
$3 FC Min Search
A AR
Pk-Pk Search
Start 1 GHz Stop § 67 flore
#Res BW 1 MHz #UBW 19 kHz Sweep 325 ms (401 pts)
|

Configuration 3, Middle Channel, Sense Antenna Horizontally Polarized, 1000-5000 MHz, at 1m.

% Agilent  16:15:41 Feb 21, 2606 | Peak Search |
Mkrl 1.868 GHz|t
Ref 75 dBpV Atten 5 dB Ext PG -0.84 dB 66.33 dBpV
Peak Meas Tools»
Log
5 1
o
dB/ Next Peak
ol Next Pk Right
63.5
dBpY
Next Pk Left
Y1 52
$3 FC Min Search
A AR
Pk-Pk Search
Start 1 GHz Stop § 67 flore
#Res BW 1 MHz #UBW 19 kHz Sweep 325 ms (401 pts)
|
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Configuration 1, High Channel, Sense Antenna Horizontally Polarized, 5000-10000 MHz, at 1 m.

% Agilent  15:33:48 Feb 9, 2006 | Peak Search |
Mkrl G.56 GHz|t
Ref 75 dBpV #Atten B dB 52.56 dBpv
Peak Meas Tools»
Log
5
dB/ Next Peak
ol Next Pk Right
63.5 -
dBpY
Next Pk Left
Y1 52
$3 FC Min Search
A AR
Pk-Pk Search
Start 5 GHz Stop 10 GHz flore
#Res BW 1 MHz #UBW 19 kHz Sweep 406.2 ms (401 pts)
|
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9. Band-Edge Measurements

FCC 15.209(b) and 15.247(d) require a measurement of spurious emission levels to be at least 20 dB lower than the
fundamental emission level, in particular at the band-edges where the intentional radiator operates. The following
screen captures demonstrate compliance of the intentional radiator at the 902 - 928 MHz band-edges. The EUT was
operated in continuous transmit mode with continuous modulation, with internally generated data as the modulating
source. The EUT was operated at the lowest channel for the investigation of the lower band-edge, and at the highest

channel for the investigation of the higher band-edge.

The screen captures on the following pages demonstrate compliance of the intentional radiator at the 902-928 MHz

band-edges, with emissions meeting the — 20 dBc limit.

Configuration 2 presented here with highest emissions.
Screen Capture demonstrating compliance at the Lower Band-Edge
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Screen Capture demonstrating compliance at the Higher Band-Edge
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10. _Conducted RF Emissions onto AC Power Line

Test Setup
The Conducted Emissions test was performed at L.S. Compliance, Inc. in Cedarburg, Wisconsin.

The test area and setup are in accordance with ANSI C63.4-2003 and with Title 47 CFR, FCC
Part 15 (Industry Canada RSS-210). The EUT was placed on a non-conductive pedestal, with a
height of 80 cm above the reference ground plane.

Power and data was provided to the EUT module by the custom test-fixture board, which in turn
received power from a typical wall type AC-adaptor, rated 5.0 VDC, 100 mA output. The AC
adaptor was plugged into a 50Q (ohm), 50/250 uH Line Impedance Stabilization Network (LISN).
AC power of 120V, 60 Hz was provided via an appropriate broadband EMI Filter, and then to the
LISN line input. After the EUT was setup and connected to the LISN, the RF Sampling Port of
the LISN was connected to a 10 dB Attenuator-Limiter, and then to the HP 8546A EMI Receiver.
The EMCO LISN used has the ability to terminate the unused port with a 50Q (ohm) load when
switched to either L1 (line) or L2 (neutral).

Test Procedure

The EUT was investigated in continuous modulated transmit mode for this portion of the testing.
The appropriate frequency range and bandwidths were selected on the EMI Receiver, and
measurements were made. The bandwidth used for these measurements is 9 kHz, as specified
in CISPR 16-1 (2003), Section 1, Table 1, for Quasi-Peak and Average detectors in the
frequency range of 150 kHz to 30MHz. Final readings were then taken and recorded.

Test Equipment Utilized

A list of the test equipment and accessories utilized for the Conducted Emissions test is provided
in Appendix A. This list includes calibration information and equipment descriptions. All
equipment is calibrated and used according to the operation manuals supplied by the
manufacturers. Calibrations of the LISN and Limiter are traceable to N.I.S.T. All cables are
calibrated and checked periodically for conformance. The emissions are measured on the HP
8546A EMI Receiver, which has automatic correction for all factors and allows direct
measurements.

Test Results

The EUT was found to MEET the Conducted Emission requirements of FCC Part 15.207
Conducted Emissions for an Intentional Radiator. See the Data Charts and Graphs for more
details of the test results.
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Calculation of Conducted Emissions Limits

The following table describes the Class B limits for an intentional radiator. These limits are obtained from
Title 47 CFR, Part 15.107 (a) for Conducted Emissions.

Frequency (MHz) Quasi-Peak Limit (dBuV) Average Limit (dBuV)
0.15-05 66 — 56 * 56 — 46
05-5.0 56 46
5.0-30.0 60 50

10Decreases with the logarithm of the frequency.

Sample calculation for the limits in the 0.15 to 0.5 MHz:

Limit = -19.12 ( Logo ( F[MHz] / 0.15 [MHz] )) + 66.0 dBpV

For a frequency of 200 kHz for example:

Quasi-Peak Limit (F = 200kHz) = -19.12 ( Logso ( 0.2[MHz] / 0.15 [MHz] )) + 66.0 dBpV

Quasi-Peak Limit (F = 200kHz) = 63.6 dBpV

Average Limit (F=200kHz) = -19.12 (Log10(0.2[MHz]/0.15[MHZ])) + 56.0 dBuV

Average Limit (F = 200 kHz) = 53.6 dBuV
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Measurement of Electromagnetic Conducted Emission

Frequency Range inspected: 150 KHz to 30 MHz
Test Standard: FCC 15.207 (a)

Manufacturer: | Heat-Timer Corporation
Date(s) of Test: | February 8™ through 24™, 2006
Test Engineer: | Tom Smith |V | Abtin Spantman | | Ken Boston
Model #: | 900 MHz RF Module
Serial #: | 05510529 and 05510534
Voltage: | 3.3 VDC

Operation Mode:

Normal, continuous modulated transmit, and ‘Hopping’ mode

Test Location: Chamber
\ | 40cm from Vertical Ground Plane 10cm Spacers
EUT PI :
> eSOl \' | 80cm above Ground Plane Other:
Measurements: Pre-Compliance Preliminary \ | Final
Detectors Used: Peak \ | Quasi-Peak \ | Average
Environmental Conditions in the Lab: Test Equipment Utilized:
Temperature: 20 —25°C EMI Receiver: HP 8546A
Atmospheric Pressure: 86 kPa — 106 kPa LISN: EMCO 3816/2NM
Relative Humidity: 30 — 60% Transient Limiter: HP 119474A
QUASI-PEAK AVERAGE
Frequency Q-Peak Q-Peak Quasi-Peak | Average Average | Average
(MHz) Line Reading Limit Margin Reading Limit Margin
(dBuV/m) | (dBp V/m) (dB) (dBpV/im) | (dBu V/m) (dB)
0.155 L1 429 66.0 23.1 29.0 56.0 27.0
0.285 L1 28.8 60.7 31.9 23.0 50.7 27.7
0.428 L1 23.6 57.3 33.7 20.2 47.3 27.1
0.568 L1 22.9 56.0 33.1 16.0 46.0 30.0
0.711 L1 26.9 56.0 29.1 20.1 46.0 25.9
2.421 L1 215 56.0 345 10.7 46.0 35.3
0.155 L2 414 66.0 24.6 31.2 56.0 24.8
0.285 L2 28.3 60.7 32.4 22.9 50.7 27.8
0.428 L2 24.6 57.3 32.7 21.4 473 25.9
0.572 L2 14.8 56.0 41.2 12.2 46.0 33.8
0.716 L2 24.5 56.0 315 18.2 46.0 27.8
0.861 L2 25.2 56.0 30.8 175 46.0 28.5
Notes:

1) All other emissions were better than 20 dB below the limits.
2) The EUT exhibited similar emissions in transmit and receive modes, and across the Low, Middle and High

channels tested.

3) All three configurations exhibited similar emissions.
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Sgtup for the Conducted Emissions Test

Lret
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Screen Captures of Conducted AC Mains Emissions:

Please note these screen captures represent Peak Emissions. For conducted emission measurements,
we utilize both a Quasi-Peak detector function as well as the Average detector function for measurements.
The emissions must meet both the Quasi-peak limit and the Average limit as described in 47 CFR 15.207.

The signature scans shown here are from the middle channel, chosen as being a good representative of

channels.

Configuration 2, Middle Channel, Line 1
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11. Occupied Bandwidth

The 20 dB bandwidth requirement found in FCC Part 15.247(a)(1)(i) states a maximum allowed
occupied bandwidth of 500 kHz. For this portion of the tests, a direct conducted measurement of
the transmitted signal was performed at the antenna port of the EUT, via a cable connection to
the HP E4407B spectrum analyzer. The loss from the cable was added on the analyzer as gain
offset settings, there by allowing direct readings of the measurements without the need for any
further corrections. A spectrum analyzer was used with the resolution bandwidth set to 30 kHz
for this portion of the tests. The EUT was configured to run in a continuous transmit mode, while
being supplied with typical data as a modulation source. The spectrum analyzer was used in
peak-hold mode while measurements were made, as presented in the chart below.

From this data, the closest measurement when compared to the specified limit, is 360 kHz,
which is below the maximum limit of 500 kHz. The device also meets the minimum of 25 hopping
channels as required by this occupied bandwidth.

Sheiig Center Frequency Measured 20 dB BW Maximum Limit
(MHz) (kHz) (kHz)
Low 903 360 500
Middle 915 350 500
High 927 345 500

Plots of Occupied Bandwidth
Occupied Bandwidth on the low channel.

% Agilent  15:28:10 Feb 17, 2006 | Marker |
Mkrl & 368 kHz|t
Ref 30 dBm fAtten 40 dB Ext PG -0.84 dB 0.488 &8 [[ s olect Marker
Peak
1 2 3 4
Log
18
dB/ Normal
1H i
4 o
5”@ Marker & Delta
dem | 360.000 kHz Delta Pair
0.488 dB {Tracking Ref)
B Ref Delta|
s Span Pair
53 FC s C
AA pan enter
Off
Center 983 MHz Span 2 Wz flore
#Res BW 30 kHz #BH 38 kHz Sweep 5 ms (401 pts)
|
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Occupied Bandwidth on the middle channel.

% Agilent  17:84:31 Feb 8, 2006 | Marker |
Mkrl & 358 kHz|t
Ref 30 dBm fAtten 40 dB Ext PG -0.84 dB 0305 dB | select Marker
Peak 1 o 3 4
Log =
18
dB/ Normal
R 1
o o
?le Marker & Delta
dem | 350.000 kHz Delta Pair
B.] @5 dB (Tracking Ref)
Ref Delta|
s Span Pair
53 FC s C
AR pan enter
Off
Center 915 MHz Span 2 Wz flore
#Res BW 30 kHz #BH 38 kHz Sweep 5 ms (401 pts)
|

Occupied Bandwidth on the high channel.

% Agilent  17:08:67 Feb 8, 2006 | Marker |
Mkrl & 345 kHz|t
Ref 30 dBm Atten 40 dB Ext PG -0.34 dB -1.161 B [ seject Marker
Peak
1 2 3 4
Log
18
dB/ Normal
R 1
%
53”5 Marker & elta
dEn | 345.000 kHz Delta Pair
-1.161 dB (Tracking Ref)
Ref Delta|
s Span Pair
53 FC s C
AA pan enter
0ff
Center 927 MHz Span 2 Tz flore
#Res BW 30 kHz #BH 38 kHz Sweep 5 ms (401 pts)
|
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12. Power Output 15.247(b)(2)

The conducted RF output power of the EUT was measured at the antenna port using a short RF
cable to the spectrum analyzer. The loss from the cable was added on the analyzer as gain
offset settings, there by allowing direct readings of the measurements made without the need for
any further corrections. The unit was configured to run in a continuous transmit mode, while
being supplied with typical data as a modulation source. The spectrum analyzer was used with
resolution and video bandwidths set to 1 MHz, with measurements from a peak detector

presented in the chart below.

CENTERFREQ | LIMT | MEASURED POWER | MARGIN
SniNE (MHz2) (dBm) (dBm) (dB)
Low 903 +24 dBm +22.8 1.0
Middle 915 +24 dBm 4227 13
High 927 +24 dBm +22.0 2.0

Notes: Limit of + 24 dBm is for systems utilizing at least 25, but less than 50 hopping channels.

Conducted Power Output on Low channel

# Agilent  15:36:69 Feb 17, 2006

! Peak Search |

Mkrl 902,98 MHz

Ref 38 dBm Atten 48 dB Ext PG -0.84 dB 22.76 dBm
Peak Meas Tools»
Log .
3 o
dB/ Next Peak
Marker Next Pk Right
902.980000 MHz
22.76 dBm Next Pk Left
Y1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 983 MHz Span 5 Mz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 5 ms (401 pts)
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Conducted Power Output on Middle channel

% Agilent  17:34:18 Feb 8, 2006 Peak Search
Mkrl 914.863 MHz|t
Ref 25 dBm Atten 35 dB Ext PG -0.54 dB 22.67 dBm
Peak Meas Tools»
Log
.5
dB/ Next Peak
22@ Marlker Next Pk Right
1
én | 914.863000. MH2
24.67 dBm Next Pk Left
M1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 915 Mz Span 1 Mz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 5 ms (401 pts)
|

Conducted Power Output on High channel

% Agilent  17:35:21 Feb 8, 2006 | Peak Search |
Mkrl 926.833 MHz|t
Ref 25 dBm Atten 35 dB Ext PG -0.54 dB 22 dBm
Peak Meas Tools»
Log
.5
dB/ Next Peak
SL@ Marker Next Pk Right
dBm 926.83:}@8% MHz
22 dBm |, Next Pk Left
< -
M1 52
$3 FC Min Search
AR
Pk-Pk Search
Center 927 MHz Span 1 Wz flore
#Res BW 1 MHz #UBH 1 MHz Sweep 5 ms (401 pts)
|
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13. Spurious Emissions 15.247(d)

FCC Part 15.247(d) requires a measurement of conducted harmonic and spurious RF emission
levels, as reference to the carrier level when measured in a 100 kHz bandwidth. For this test,
the spurious and harmonic RF emissions from the EUT were measured at the EUT antenna port
using a short RF cable with a spectrum analyzer. The loss from the cable was added on the
analyzer as gain offset settings, there by allowing direct readings of the measurements made
without the need for any further corrections. A Hewlett Packard model E4407B spectrum
analyzer was used with the resolution bandwidth set to 100 kHz for this portion of the tests. The
unit was configured to run in a continuous transmit mode, while being supplied with typical data
as a modulation source. The spectrum analyzer was used with measurements from a peak
detector presented in the chart below. Screen captures were acquired and any noticeable
spurious and harmonic signals were identified and measured.

No significant emissions could be noted within -40 dBc of the fundamental level for this product.

Low Channel Middle Channel High Channel Limit

115-117 MHz - 26.6 (dBm) - 26.2 (dBm) - 24.7 (dBm) -20dBc
795-812 MHz - 25.4 (dBm) - 24.7 (dBm) - 24.3 (dBm) -20 dBc
862 MHz - 27.2 (dBm) Note (1) Note (1) -20 dBc
957 MHz - 28.6 (dBm) Note (1) Note (1) - 20 dBc
1020-1045 MHz - 33.8 (dBm) - 27.4 (dBm) - 27.3 (dBm) -20 dBc
Fundamental +21.9 (dBm) + 21.5 (dBm) + 20.09 (dBm) | Reference
2"4 Harmonic - 39.7 (dBm) - 54.4 (dBm) - 50.5 (dBm) -20 dBc
3™ Harmonic - 77.2 (dBm) - 77.7 (dBm) -82.3(Bm) | -20dBc
4™ Harmonic - 78.5 (dBm) - 77.7 (dBm) - 82.2 (dBm) - 20 dBc
5™ Harmonic - 79.1 (dBm) - 79.8 (dBm) - 81.1 (dBm) -20dBc
6™ Harmonic - 79.0 (dBm) - 79.2 (dBm) - 77.8 (dBm) -20 dBc
7™ Harmonic - 78.7 (dBm) - 79.2 (dBm) -80.9 (@Bm) | -20dBc
8" Harmonic - 71.2 (dBm) - 71.4 (dBm) - 60.8 (dBm) -20 dBc
9™ Harmonic - 73.4 (dBm) - 73.7 (dBm) - 70.5 (dBm) - 20 dBc
10™ Harmonic - 71.4 (dBm) - 73.0 (dBm) - 61.5 (dBm) -20dBc

Notes:

(1) Measurement at system noise floor.
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The wide screen captures show spurious emissions as measured at the RF port. The actual
measurements were made with 500 kHz span on the spectrum analyzer.
The middle channel is chosen as a good representative of all channels.

30 MHz up to 1000 MHz

# Agilent  18:28:28 Feb 8, 2006 | Trace/View |
Mkrl a -114 MHz|t

Ref 35 dBm Atten 45 dB Ext PG -0.84 dB -56.16 dB Trace
Peak 1 5 3
Log o X 2
18 )
dB/ Clear Write
Start Max Hold
30.p0000000 MH=
Min Hold
Y1 W2 1
53 FCL e s s IR 2 View
AR
Blank
Start 38 Mz Stop 1 617 flore
#Res BH 100 kHz #UBH 188 kHz Sweep 125 ms (401 pts)

1000 MHz up to 10,000 MHz
% Agilent  19:35:37 Feb 8, 2006

i

Trace/View
Mkrl 1.83 GHz
Ref -35 dBm #Atten 1@ dB Ext PG -0.84 dB -54.59 dBm Trace
Peak
il 2 3
Log
5
dB/ Clear Write
(1) Max Hold
Min Hold
Y1 52
$3 FC View
AR
7 Blank
Start 1 GHz Stop 10 GHz flore
#Res BH 100 kHz #UBH 188 kHz Sweep 1.16 5 (481 pts)
|
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14. _Minimum Channel Separation

Part 15.247(a)(1) requires a minimum channel separation of 25 kHz or the equivalent of the 20
dB occupied bandwidth of the fundamental transmission, whichever is greater. An HP E4407B
spectrum analyzer was used with a resolution bandwidth of 30 kHz to measure the channel
separation of the EUT.

The channel-separation measured for this device is 1 MHz. The maximum occupied bandwidth
of the device, as reported in the previous section is 360 kHz. The minimum channel separation
for the EUT exceeds both the 25 kHz criteria and the 20 dB occupied bandwidth criteria, and
hence meets the requirements. By having an occupied bandwidth greater than 250 kHz, the
system must utilize at least 25 hopping channels. The following plots describe this spacing, and
also establish the number of hop channels at a total of 25.

Frequency Span Number of Channels Minimum Separation
902.0 — 904.5 MHz 2 1.0 MHz
904.5 - 907.5 MHz 3 1.0 MHz
907.5-910.5 MHz 3 1.0 MHz
910.5-913.5 MHz 3 1.0 MHz
913.5-916.5 MHz 3 1.0 MHz
916.5-919.5 MHz 3 1.0 MHz
919.5-922.5 MHz 3 1.0 MHz
922.5-925.5 MHz 3 1.0 MHz
925.5 - 928.5 MHz 2 1.0 MHz

Hop Mode verification of 25 channels

# Agilent  15:44:47 Feb 17, 2006 ! Peak Search |
Mkrl 983.11 MHz

Ref 38 dBm Atten 48 dB Ext PG -0.84 dB 23.83 dBm
Peak Meas Tools»
Log )
5 ¢
dB/ Next Peak
Next Pk Right
Next Pk Left
Y1 52
$3 FC Min Search
AR
Pk-Pk Search
Start 982 Mz Stop 928 MHz flore
#Res BH 109 kHz #UBH 188 kHz Sweep 4 ms (401 pts)
I
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Plots of Channel Separations

Channels 01 through 02

¥ Agilent

15:08:43 Feb 17, 2086

| Tracesview
Mkrl & 1.888 WHz]t
Eef 25 dBm Peten 35 dB Eat PG -6.9 dB -0.345 dB Trace
eak o & 2 3
Log iR 1 —
1a
B/ Clear Write
Marker Max Hold
1.0D@BOA MHEz
“B346 a8 Min Hold
Ul 52
33 FC View
AR
Blank|
Start 992 Mz Trop 9645 Mz frore
#Res BH 30 kHz #UBH 36 kHz Sweep 5 ms (401 pts) 0

Channels 03 through 05

- Agilent  15:02:45 Feb 17, 2066 | Marker
Mkrl & 1885 MHz|t
Ref 25 dBm Ptten 35 dB Est PG -8.9 dB 5.856 dB Select Marker
Peak T Py i
Log 1 =
1a |
B/ Normal
Matlker Delta
ANCARAR
1.2p5000 MHz Delta Pair
@ 56 jB (Tracking Ref)
Ref Delta|
g% FSS $pan Pair
P Span Center
Off
Start 9945 Mz Stup 987.5 iz 1”‘;{3
#Res BH 38 kHz #UBH 30 kHz Sweep 5 ms (401 pts)

Channels 06 through 08

- Agilent  15:04:28 Feb 17, 2086 | Marker
Mirl & 1.885 MHz[t
I;ef 25 dBm Atten 35 dB Ext PG -8.9 dB -0.425 dB Select Marker
sak N N i
Log 1R 1 —
1a
dB/ Normal
| Marker Delta
1.0P5000 MHE Delta Pair
-0.425 1B (Tracking Ref)
Ref Delta]
ML 52 Span Pair
$3 FC 5 C
AR nan enter
off
Start 997.5 MHz Stap 9105 Mz 1”‘0’{2
#Res BH 30 kHz #WBH 38 kHz Sweep 5 ms (401 pts)
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Channels 09 through 11

- Agilent  15:85:33 Feb 17, 2005 | Marker |
Mkrl & 1.885 WHz]L
Ref 25 dBm Btten 35 dB Est PG -6.9 dB 5.185 dB Select Marker
Peak
o 1 2 3 4
Log 1
14
dB/ Normal
Marker Delta
1885000 MHE Delta Pair
0.185 dB (Tracking Ref))
Ret Delta)
hl 52 Span Pair
$3 FC s c
AR pan anter
off
Start 910.5 MHz Stop 9135 MHz 1”‘0’{2
#Res BH 30 kHz #WBH 38 kHz Swesp 5 ms (401 pts)
|
Channels 12 through 14
% Agilent  15:06:48 Feb 17, 20086 | Marker |
Mkrl & 1885 WHz]t
Ref 25 dBm Peten 35 dB Eat PG -6.9 dB -0.03 dB Select Marker,
Peak TF T
L ® &
09
1a
B/ Normal
| Marker Delta
e 533 ng MHz Delta Pair
=, (Tracking Ref)
Ref Delta|
M52 Span Pair
53 FC s C
AR pan anter
off
Start 913.5 MHz Stop 916.5 MHz 1”‘0’{2
#Res BH 30 kHz #WBH 38 kHz Swesp 5 ms (401 pts)

Channels 15 through 17

|
|I Marker

- Agilent  15:07:41 Feb 17, 2086
Mkrl & 1.885 MHz
E:;kES dBm Rtten 35 dB Ext PG ;@.9 dB 8.636 dB Select Marker,
Log & L
18
B/ Normal
Marker Delta
AACARARA
,1.0P5000 MHz Delta Pair
6@36 1B (Tracking Ref)
Ref DeltaJ
g% FSS Span Pair
AR Span Center
Off
Start 916.5 Mz Stop 919.5 Mz 1”'0’{2
#Res BH 30 kHz #UBH 38 kHz Sweep 5 ms (401 pts)

L.S. Compliance, Inc.
Test Report Number: 305440-Tx-v1
Prepared For: Heat-Timer Corporation

Page 40 of 53



Channels 18 through 20

% Agilent  15:08:33 Feb 17, 2006 | Marker |
Mkrl & 1865 MHz]t
Ref 25 dBm Bten 35 dB Ext PG -6.9 dB -0.021 dB Select Marker,
Peak 1 1
Log b
1@
B/ Normal
_M:rbnr Delta
10A5000 MHg Delta Pair
-0.p21 dB (Tracking Ref)
Ref Delta]
M s Span Pair
53 FC s C
AR pan enter
0ff
Start 9195 Tz Stop 9225 Mz frore
#Res BHW 38 kHz #YBH 38 kHz Sweep 5 ms (401 pts) 0

Channels 21 through 23

- Agilent  15:09:53 Feb 17, 2086 | Marker
Mirl & 1.885 MHz[t
R:LkZS dBm - Rtten 35 dB Ext 1PG -0.9 dB -6.154 dB Select Marker
Log o o | L
18
dB/ Normal
Madker Delta
1.0p5000 MH:= Delta Pair
—@154 jB (Tracking Ref)
Ref DeltaJ
ML 52 Span Pair
$3 FC 5 C
AR nan enter
Off
Start 922.5 Mz Stop 925.5 Mz 1”'0’{2
#Res BH 30 kHz #UBH 38 kHz Sweep 5 ms (401 pts)

Channels 24 through 25

- Agilent 1518

53 Feb 17, 2066

|
II Marker

Mkrl & 1.085 MHz

Ref 25 dBm Atten 35 dB Ext PG -8.9 dB 8.875 dB Select Marker,
Peak iR 1 L2 34
Log & < L
16
a8/ Normal
Marker Delta
713 5000 Mz Delta Pair
0875 dB (Tracking Ref)
Ret Deltal
Z% Eé $pan Pair
Span Center
AR =
Off
Start 9255 Mhz Stop 928.5 MHz 1”‘0’{2
#Res BW 30 kHz #WBH 38 kHz Sweep 5 ms (401 pts)
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15. Channel Occupancy

Part 15.247(a)(1) requires a channel occupancy, for this device, of no more than 400
milliseconds in a 10 second window. The channel occupancy for this EUT was measured using
an HP E4407B spectrum analyzer, set to zero-span at the frequency of interest. With the
analyzer in peak-hold mode, the transmission lengths can be measured by adjusting the sweep
rate of the analyzer. A suitable sweep rate was used to measure the channel occupancy at the
low, mid and high channels. The longest time any transmission will occur on a single channel is
166.5 ms. With a total of 25 channels used, each occupying a 166.5 ms slot, it will take 4.163
seconds for the sequence to repeat. In a 10 second window, each channel would have 2.4
transmission cycles. The maximum occupancy in a 10 second window is calculated by
multiplying the 2.40 transmission cycles by 166.5 ms transmission duration per cycle, to arrive at
399.6 ms total occupancy.

Frequency Occupancy Occupancy in
Channel (MHz) Per transmission 10s window
(ms) (ms)
Low 903 166.5 399.6
Middle 915 166.5 399.6
High 927 166.5 399.6
Plots of Channel Occupancy
Occupancy on lowest channel
¥ Agilent 16:00:24 Feb 17, 2006 [ Marker
Mkrl & 166.5 ms|t
Ref 38 dBnm Atten 40 dB Ext PG -0.84 dB -53.77 & |[serect Marker
Feak T 2 3 4
Log =
2
dB/ Normal
ik
Manker—& elta
166.5000000 ms Delta Pair
-53.77 ¢B {Tracking Ref)
Ref Deltaf
gé Sg Span Pair
aa Span Center
Off
s
Center 902.9 Mz Span 0 Hz flore
Res BH 1 MHz #UBH 1 MHz Sweep 600 ms (401 pts) .
|
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Occupancy on middle channel

% Agilent  16:48:19 Feb 17, 2006 | Marker |
Mkrl & 166.5 ms|k
Eefk% dBm Atten 48 dB Ext PG -0.84 dB -53.04 dB Select Marker
Lea «IL 2 3 4
og
2
dB/ Normal
1| Delta
. Marker. A
16EJ.5@@@@@@ ms Delta Pair
-53.04 dB {Tracking Ref)
Ref Deltal
gé Sg Span Pair
aa Span Center
Off
1
= More
Center 914.9 MHz Span @ Hz 1 of 2
Res BH 1 MHz #UBH 1 MHz Sweep 600 ms (401 pts)
|
Occupancy on highest channel
% Agilent  16:54:31 Feb 17, 2606 | Marker |
Mkrl & 166.5 ms|k
Eefk% dBm Atten 48 dB Ext PG -0.84 dB -51.96 dB Select Marker
&8 1 2 3 4
Log
2
dB/ Normal
Jk-Marker & Delta
166.5000000 ms Delta Pair
-51.96 dB {Tracking Ref)
Ref Deltal
HL 2 Span Pair
53 V%
aa Span Center
Off
1
2 More
Center 927.1 MHz Span @ Hz 1 of 2
Res BH 1 MHz #UBH 1 MHz Sweep 600 ms (401 pts)
|
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Occupancy on middle channel in a 20 second window,
demonstrating 2.4 hop cycles in 10 seconds, or 5 cycles in 20 seconds as shown below.

% Agilent  16:58:32 Feb 17, 2006 | Peak Search |
Mkrl 9 s|t

Ref 38 dBm Atten 48 dB Ext PG -0.84 dB 22.82 dBm
Peak Meas Tools»
Log
2
dB/ Next Peak
Next Pk Right
Next Pk Left
H1 52
$3 U8 Min Search
AR
Pk-Pk Search
Center 914.9 Mz Span 0 Hz flore
Res BH 1 MHz #UBH 1 MHz Sweep 2@ 5 (401 pts) .
|
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16. Frequency and Power Stability requirements

For this portion of the tests, a spectrum analyzer was used to measure the frequency at the appropriate frequency
markers, with the transmitter portion of the EUT placed in modulated continuous transmit mode for the power
measurements, and CW mode for the frequency measurements. Power was supplied by an external bench-type
variable power supply, and the frequency of operation was monitored using the spectrum analyzer

. The output power was measured with a receiver resolution bandwidth of 1 MHz, and video bandwidth of 1 MHz.

DC Voltage Source
2.80V 3.30V 3.80V
Low Channel +21.5 (dBm) +22.8 (dBm) +24.0 (dBm)
Mid Channel +21.1 (dBm) +22.7 (dBm) +23.7 (dBm)
High Channel +20.3 (dBm) +22.0 (dBm) +23.0 (dBm)

. The frequency was measured with a receiver resolution bandwidth of 1 kHz, and video bandwidth of 1 kHz.

DC Voltage Source
2.80V 3.30V 3.80V
Low Channel 902.99700 (MHz) 902.99650 (MHz) 902.99650 (MHz)
Mid Channel 914.99730 (MHz) 914.99750 (MHz) 914.99730 (MHz)
High Channel 926.99755 (MHz) 926.99700 (MHz) 926.99710 (MHz)

The power was then cycled On/Off to observe system response. No unusual response was observed, the emission
characteristics were well behaved, and the system returned to the same state of operation as before the power cycle.

No anomalies were noted, in the measured transmit power, varying -1.7/+1.2 dB, during the voltage variation tests.
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The information on this page is provided by the manufacturer.

17. Equal Channel Usage

The 25 channels are arrayed in a table which the system uses to determine the next hopping
channel. Each time a transmission is made the system uses the next frequency in the table. The
table is started over once the end has been reached. Thus, any given frequency will not be
reused until all other frequencies have been accessed. This also addresses part 15.247(g)
concerns.

18. Pseudorandom Hopping Pattern

The hopping patterns were chosen to maintain uniform usage of the spectrum, while
maintaining the pseudorandom nature of the channels. The Frequency hopping table is
defined in this chart:

Frequency | Frequency Frequency | Frequency
Order (MHz) Order (MHz)
1 910 14 927
2 919 15 923
3 911 16 916
4 918 17 909
5 912 18 908
6 907 19 917
7 904 20 922
8 903 21 925
9 905 22 921
10 913 23 926
11 906 24 924
12 915 25 914
13 920
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19. Receiver Synchronization

The module uses 25 frequencies for hopping, separated by 1 MHz from each other in a
pseudorandom sequence. It dwells on each frequency listed in the frequency hopping
table for a nominal period of 170 milli-seconds.

Whenever synchronization is required, a Slave hops at the frequencies listed in the
table, but in “reversed” sequential order, while the Master always hops through a forward
progressing sequential order.

At each frequency, the slave sends a beacon request.

If after hopping throughout the 25 frequencies, the Slave does not receive a beacon
acknowledge, it dwells for a nominal duration of 85 ms on the first frequency only, and
then continues hopping in the “reversed” sequence in 170 ms intervals.

When the two modules’ frequencies coincide, the Master sends a beacon acknowledge.
Once the Slave receives that beacon acknowledge, it will change the direction of

frequency hopping to a forward sequential type, following the same sequence the Master
hops.

20. Receiver Input Bandwidth

The EUT receiver section has a bandwidth of 200 kHz. There are two filters in the
receiver path, a 230 kHz 3P order Sallen-Key preceding a 6-pole elliptical switched
capacitor LPF at 200 kHz.

The module uses 25 frequencies for hopping, separated by 1 MHz from each other in a
pseudorandom sequence. It dwells on each frequency listed in the frequency hopping
table for a nominal period of 170 milli-seconds.
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21. MPE Calculations

900 MHz Transceiver Module

MPE Calculation based on the highest gain antenna configuration

Configuration Antenna MFG Model Gain
1 Antenna Factor ANT-916-CW-RH 2.5dBi
2 Antenna Factor ANT-916-MHW-RPS 2.0 dBi
3 “Generic Wire Whip” 8 cm long, 22 AWG 4.1 dBi®™e"

Notes:

1) The antenna gain was calculated based on empirical electric field intensity measurements above a conductive
ground plane. The antenna gain figure listed is not free-space antenna gain.

Prediction of MPE limit at a given distance

Equation from page 18 of OET Bulletin 65, Edition 97-01
PG

S=——_— -
47R?

S = power density
P = power input to the antenna

where:

G = power gain of the antenna in the direction of interest relative to an isotropic radiator

R = distance to the center of radiation of the antenna

Maximum peak output power at antenna input terminal:

22.80 (dBm)

Maximum peak output power at antenna input terminal:

190.546 (mW)

Antenna gain(typical):

4.1 (dBi)

Maximum antenna gain:

2.570 (numeric)

Prediction distance:

20 (cm)

Prediction frequency:

915 (MHz)

MPE limit for uncontrolled exposure at prediction frequency:

0.62 (mW/cm”2)

Power density at prediction frequency:
Maximum allowable antenna gain:

Margin of Compliance at 20 cm=

0.097438 (mW/cm”2)
12.1 (dBi)

8.0 dB
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Appendix A

Test Equipment List

Asset # Manufacturer Model # Serial # Description Date Due
Line Impedance Stabilization
AA960008 | EMCO 3816/2NM 9701-1057 Network 9/27/05 9/27/06
AA960031 HP 119474A 3107A01708 Transient Limiter Note 1 Note 1
AA960077 | EMCO 93110B 9702-2918 Biconical Antenna 9/27/05 9/27/06
AA960078 | EMCO 93146 9701-4855 Log-Periodic Antenna 9/27/05 9/27/06
AA960081 | EMCO 3115 6907 Double Ridge Horn Antenna 12/07/05 12/07/06
CC00221C | Agilent E4407B US39160256 Spectrum Analyzer 12/29/05 12/29/06
EE960004 | EMCO 2090 9607-1164 Device Controller N/A N/A
EE960013 | HP 8546A 3617A00320 Receiver RF Section 9/29/05 9/29/06
EE960014 HP 85460A 3448A00296 Receiver Pre-Selector 9/29/05 9/29/06
N/A LSC Cable 0011 3 Meter %" Armored Cable Note 1 Note 1
N/A LSC Cable 0050 10 Meter RG 214 Cable Note 1 Note 1
N/A Pasternack Attenuator N/A 10 dB Attenuator Note 1 Note 1

Note 1 - Equipment calibrated within a traceable system.

Uncertainty Statement

This uncertainty represents an expanded uncertainty expressed at approximately the 95% confidence level,
using a coverage factor of k=2.

Table of Expanded Uncertainty Values, (K=2) for Specified Measurements

Measurement Type Particular Configuration Uncertainty Values
Radiated Emissions 3 — Meter chamber, Biconical Antenna 4.24 dB
Radiated Emissions 3-Meter Chamber, Log Periodic Antenna 48dB
Radiated Emissions 10-Meter OATS, Biconical Antenna 4.18dB
Radiated Emissions 10-Meter OATS, Log Periodic Antenna 3.92dB

Conducted Emissions Shielded Room/EMCO LISN 1.60 dB
Radiated Immunity 3 Volts/Meter in 3-Meter Chamber 1.128 Volts/Meter
Conducted Immunity 3 Volts level 1.0V
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Appendix B

Antenna Specification
Antenna Configuration 1

NTENNA
FFALTOR ANT-916-CW-QW DATA SHEET

< Product Dimensions <~ Description

=  CW Series 1/4-wave antennas deliver outstanding per-

formance in 3 rugged and cosmebicaly atractive pack-

age. These antennas feature an SMA or FCC Part 13

. compliant RP-SMA connector. This smplifies packaging

_.__I |_,,‘_ 0.3 and shipment, allowing for easy field replacement while

e (78 complying with FCC regurements. & wide variety of

r _ t matching connectors alkows numerous mounting opfions.

0.1 The CW Series comes standard i black. but custom

{13.0) 024" colors are available with a 5,000 plece rmmimum order.
— -

(6.0)
I <~ Features

‘301“'}, + Low cost

Lt + Outstanding VEWR

205 * Emclient perfomance

{520 " Drr'nl-::lrecu_l:-na pattm

* Flexible main shaft

* Fully weatherized & damage-resistant
+ RP-SMA or SMA connecior

+ Available in black or custom colors

+_IZI.1B'

4.5) Use with plastic™ or metal enclosures
T " Requires prodmity ground plane

05T <~ Electrical Specifications
(14.5) + Center Freg. G16MHz

}-—b| Bandwidth  100MHz

Wawelength  1M4-wave

Gain TBD
Connector FP-ShA or SMA
Niote: Elecirical spacifications and plols measured on 4"y £" refenence ground plane

< Ordering Information

= ANT-B1E Q%Y (with RP-SMA connectaor)
= ANT-DIE-CMROWLEMA (with SMA connector)

-
End View » VEWR <18 typ. at center
+ |Impedanze 50 ohms

—!-| -—(.25"

6.4)

< Plots

211 8WR Ties0

o "]
]

CENTER §16.000MHz SPAN 200 D00MH:
Elevaticn Typical VSWR

Antenna Factor 575 5.E. Ashley Place Grants Pass. OR B7528-3237 www.antennafactor.com
541-356-0231 (phone) 541-471-8251 (fax) Ry O7-25-05
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Antenna Specification

Antenna Configuration 2

FACTOR

NTENNA _SPECIFICATION SHEET
A MHW SERIES ANTENNAS

0.36"

0.03" (Adhesive Pad)

ELECTRICAL SPECIFICATIONS

1.30" - 916MHz
2.80" - 418MHz
1.99" ] s
Pl
] fa—o0.50"
—I-:‘-—ﬂ.z?'

=3

=

SPECIFICATION ANT-418-MHW-RPS ANT-433-MHW-RPS ANTH 6-MHW-RPS
Frequency Range A10-426 425-444 281-851
Bandwidth & 16 T
(5ain 2dB 2dBEi 2dB
VEWA. =1.5 <1.5 <1.5
Imp=dance B0 ] SOE
e Powar SO SO S0
Lergth 6.0 EEd EXS
Connector AP-SMA or SMA HP-SRA or SHA HF-SKA or SMA
Cable 7 ar1g Ta'or 18 7atar18'
ORDERING INFORMATION
PART # DESCRIFTICHN

sNTooecMHW- 4 | MHW Seiies Antenna

poot = 418, 423 or 916 »** = APS (AP-SMA) or SMa
E=5{7e%orL{15)

RP-SMA Connaclor Standard.
Other torminations avalable for wlume orders.

For additional information, pleasa contact Antenna Factor at 800-488-1634
BReciplent understands any or all of the above specifications are subject to change withow nolice and proceeds with inlegralion alt own nisk.

Reviosd 32709
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REVISION RECORD
REV. DESCRIPTION: DATE:
1_|FIRST PROTOTYPE RELEASE 8-23-05
2 _|UPDATED PER ECN-050127-00-1 1-15-05
2.2 |UPDATED PER ECN-050127-00-3 3-6-05
NOTES:
1. ALL DIMENSIONS IN INCHES.
2. TOLERANGE — +-.020", UNLESS NOTED OTHERWISE
3. MATERIAL — 20 AWG PVC INSULATED SOLID COPPER HOOK-UP WIRE
POSSIBLE SOURCES;
GENERAL CABLE — PART NUMBER C2028 (BLACK)
le ~
%o.omw: NOMINAL
—

015" = =

§

HEAT TIMER

FAIRFIELD, NJ

ORAWN BY: DATE: TITLE:

DMS 8-16-05 WIRELESS BOILER CONTROL MODULE — ANTENNA DRAWING
CHECKED BY: DATE: PROJECT. HEAT TIMER “Mmm
APPROVED BY: DATE: SIZE: DRAWING NO: REV:
PRINT DATE: > NOOANO\OO\MMM N.M
FILENAME:  050127-00—2_2.pch SCALE: 170 1 [ pace 1 o 1

050127-00-2_2.pcb - Fri Mar 10 10:54:50 2006



Appendix C

Firmware and Setup Instructions

The test modes required were programmed via DIP-Switches on a special interface test board, as provided
by the manufacturer. The test board also has an RS-232 port for monitoring the programming and
communication to the module.
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